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FE 257 GIS LAB 4 
Proximity Tools 
Buffering Streams Based on Land Uses, Analyzing Nesting Locations within Stream Buffers, and Examining 
Geology Classes within Stream Buffers 
 
This lab will ask you to explore and apply a few tools in ArcMap. We will use clip, buffer and dissolve to demonstrate 
how these overlay and proximity tools can be used. 
 
Open the Windows Explorer and navigate to the t:\classes\fe257\gislab4 location on the forestry network. Using the 
mouse, right click on this folder and choose Copy from the menu that appears. Use Explorer to navigate to your 
workspace\fe257 folder. For most of you this will be located on the n:\drive and the will have the same name as your 
user name- for me it is \nicolatk\fe257. Right click on your workspace folder and choose Paste from the menu that 
appears. This should copy the gislab4 folder and all files located under the folder to your fe257 workspace.  
 
Open a new blank map in an ArcGIS Pro session. 
 
Map 
 
Let’s save our map document immediately as “Lab4.aprx” in your workspace\gislab4 folder. 
 
Add each of the three shapefiles that should be in your gislab4 folder into a data frame by using the same method as 
Labs 1 and 3: connecting to the gislab4 folder and using the Add Data button. 
 

  
 
Once you have the connection, you should be able to open the data layers. We want to open the Watersheds and 
Streams layers - don’t worry about the other data files for now. 
 

 
 

Rename the data frame view to “All Watersheds” by right clicking > Properties > General and typing “All Watersheds” in 
the Name box. You can also rename layers by single clicking on them in the Contents window. Rename the streams layer 
to “Streams” and the watersheds layer to “Watersheds.” You may also want to change the appearance of these layers by 
right clicking on them in the Contents > Symbology. Your map should look similar to the graphic below. 
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Let's create a new shapefile of only those streams that are located in the Middle Siletz Watershed through an attribute 
selection process. First, click on the Watersheds layer to highlight it in the Contents window. Then go to the Map toolbar 
and click Select By Attributes.  
 

 
 
Set the Input Rows to Watersheds and the selection type to New selection. Build a query expression that reads "Where 
NAME is equal to MIDDLE SILETZ RIVER.” Click Run. 
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You can close the Select By Attributes box after clicking Run. This process should select the Middle Siletz Watershed 
boundary, meaning that the entire watershed area is selected. 
 

 
 
Selection by Location 
 
In the last lab exercise, we used a clip operation to create a new layer. Select By Location is another way of using a shape 
to select features within another shape. This menu choice is available under the Map menu- go ahead and activate this 
option with the Middle Siletz Watershed still selected. 
 

 
 
In the Select Layer By Location box, the Input Features are Streams, the Relationship is Intersect, the Selecting Features 
are Watersheds, and the Selection Type is New Selection. Leave all other boxes blank.  
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You can close the dialog box after you click Run. This operation should select all streams in the Middle Siletz Watershed. 
 

 
 
Let’s convert the selected streams into a shapefile we can work on. With the Middle Siletz streams still selected, right 
click on the Streams layer in the Contents window, choose Data from the pop-up menu, and then select Export Features.  
 
The Feature Class to Feature Class dialogue box will open. Input Features will be Streams. Direct the output to your 
gislab4 folder and name the Output Feature Class “midsilstrms.shp.” Double check that you are exporting to your gislab4 
folder, since the same file now exists in your gislab3 folder after completing Lab 3. Keep all other defaults and click Run. 
 

 
 
This will add the new Middle Siletz streams layer to your data frame. You may not be able to see the new streams due to 
the bright blue selection color taking precedence over other display colors. You can fix this by choosing Clear from the 
Selection menu in the Map toolbar. Turn off the Streams layer to view only midsilstrms.shp and make sure it worked. 
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Create a new data frame for midsilstrms by choosing Insert > New Map. Rename the new data frame Middle Siletz. 
 
Next copy the new layer (midsilstrms) from the All Watersheds data frame by right clicking on it and choosing Copy, and 
then right clicking on the Middle Siletz data frame in the Contents and choosing Paste. You can then remove the layer 
from the All Watersheds data frame by right clicking on the layer and choosing Remove. Rename the midsilstrms layer to 
Middle Siletz Streams. 
 
You may want to change the display of the Middle Siletz Streams layer by right clicking on the layer > Symbology.  
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Save your map project! 
 
Buffer 
 
Buffering is a very important proximity tool for many GIS packages, particularly in forestry as we often establish zones or 
management areas by measuring a set distance away from a stream or land cover type. To demonstrate the use of 
buffering tools within ArcGIS, we’re going to buffer streams based on stream order information. We will create a buffer 
around the Middle Siletz Streams shapefile you just created. We’ll buffer first order streams (smaller tributaries) by 100 
feet and second and third order streams (larger waterways) by 200 feet. You will need to create a buffer field in the 
Middle Siletz Streams attribute table then populate the buffer field by using the Field Calculator. The Field Calculator is a 
very versatile tool that allows you to perform mathematical calculations.  
 
Begin by opening the attribute table for the Middle Siletz Streams. Create a new field by clicking Add button at the top 
of the attribute table. An input row should appear. In the Field Name box, enter buffer. Data Type is Short. Set the 
Precision to 4 since we will not be entering many digits into this field. Click Save in the Fields toolbar at the top of the 
screen and the rest of the row will auto populate.  
 

 
 
The buffer field should appear at the end of the Middle Siletz Streams attribute table. 
 

 
 
Select a subset of the records in this layer that include all stream segments classified as a first order stream. Click on the 
Middle Siletz Streams layer in the Contents window to highlight it. 
 
1. Choose Select by Attributes in the Map toolbar. 
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2. The Select Layer By Attribute dialogue box will open. Make Middle Siletz Streams the Input Rows and New Selection 
the Selection Type. There is a field in this table named ORDER_. When you build your query expression, it should be: 
Where ORDER_ is equal to 1. Click Run. 

 

 
 
This operation should result in all the first order streams in Middle Siletz Streams being selected. All the first order 
streams should be tributaries; this is how you know your selection was successful and makes sense. 
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Now, any calculations that we do on other fields should only occur in the selected first order streams. Add a buffer value 
for the first order streams by right clicking on the “buffer” field heading we just created and choosing Calculate Field. 
 

 
 
The Field Calculator should open. Type 100 into the “buffer = ” box at the bottom, leave everything else as default, and 
click Run. Take a look at your table to see if anything’s changed – be careful not to click on any of the table cells or this 
will invalidate your selection! 

 
 
Add buffer values for the other streams by first clearing your order 1 selection using “Clear” from the Selection menu in 
the Map toolbar.  
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Next, build two new query expressions for order 2 and 3 streams using the Select by Attributes tool. Since we are giving 
both orders the same buffer value (200’), we can select them using an OR clause. Your first expression should read: 
"Where ORDER_ is equal to 2.” Then click “Add Clause” and create a second expression reading “OR ORDER_ is equal to 
3.” Click Run. All order 2 and 3 streams should be selected. These streams should be larger, downstream waterways; this 
is how you know your selection was successful and makes sense. You can also check by noting that there are 25 first 
order streams selected and 24 second and third order streams selected, adding up to the total number of streams: 49. 
 

 

 
 
Add a buffer value for the second and third order streams by right clicking on the top of the buffer field and choosing 
Calculate Field from the options. The Field Calculator should open. Type 200 into the “buffer = ” box at the bottom, 
leave everything else as default, and click Run. Take a look at your table to see if anything’s changed – again, be careful 
not to click on any of the table cells! 
 
This process should have created a buffer field and values for us to run our buffering operation. Let’s look briefly at the 
results in the Middle Siletz Streams attribute table. 
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After looking at the results and making sure we have no sub-selected stream records, we’re ready to create stream 
buffers. You can clear the sub-selections by clicking Clear in the Selection menu under the Map toolbar. 
 
Creating Stream Buffers 
 
Our first task will be to make sure that the map coordinate units are set to feet. Right click to access Properties > 
General of the Middle Siletz data frame and make sure both the map and display units are set to feet. 
 

 
 
 
To access the buffering tool, search for it in the Geoprocessing dialogue box and click on it. 
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This should open the Buffer dialog box. Fill out the options using the graphic below as a guide. It is critical to set the 
Dissolve Type to “Dissolve all output features into a single feature.” Direct the Output Feature Class “midsilbuffer.shp” 
to your gislab4 folder. Click Run. 
 

 
 
Save your map project! 
 
Once you’ve saved your map project, rename the new layer to Middle Siletz Buffer and examine the buffer results to see 
if they match our expectations. Change the buffer layer symbology to see it more clearly. First order streams should 
have a smaller-width buffer than second and third order streams with a larger-width buffer. The graphic below is just an 
excerpt, but the entire Middle Siletz Buffer layer should look like this. Every stream should contain a buffer; if some 
don’t (like the smaller ones), you will need to redo the process. Since you chose the “Dissolve all output features into a 
single feature” option, Middle Siletz Buffer is now a single polygon layer with one attribute in its table. You may have 
noticed that there is no area field in the buffer attribute table. 
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How to Add or Update Area Measurements for Polygon Layers 
 
The updating of measurements is something you should do to a polygon or line layer every time you change the 
dimension (size) of the layer! 
 
Add an area field to the Middle Siletz Buffer layer. Open the Middle Siletz Buffer attribute table and click “Add” in the 
Field menu at the top of the table. Type Area into Field Name and leave the rest as default. Click Save in the Fields 
toolbar at the top of your screen and the rest of the cells will auto populate. 
 

 
 
Now use the Calculate Geometry tool to create an area measurement for the entire buffer polygon. Go back to the 
Middle Siletz Buffer table and right click on the Area field heading to select Calculate Geometry. In the Calculate 
Geometry Attributes window that appears, Input Features are Middle Siletz Buffer, Target Field and Property are both 
Area, and Area Unit is Square feet (United States). Leave Coordinate System blank. Click Run. 
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The Area field in the Middle Siletz Buffer attribute table should now be populated with the area in square feet. 
 

 
 

Dissolving a Layer 
 
We also have a shapefile that contains surficial geology for our watershed areas. We’re going to open this file and clip it 
to the extent of the Middle Siletz Watershed so that we can do some processing. 
 
Return to your All Watersheds data frame. Clear any selections you might have by using the Clear option under the 
Selection Menu. Make the Middle Siletz Watershed the active polygon by using the Select tool and clicking on the 
Middle Siletz Watershed to select it. Make sure not to click on the Streams layer in the process. 

  
Create a new shapefile of this watershed area by right clicking on the Watersheds layer > Data > Export Features. Write 
the output to your gislab4 workspace folder and name it midsilshed.shp. Add the new layer to your data frame and 
name it Middle Siletz Watershed. 
 
Now, open the geology shapefile into the All Watersheds data frame by using the Add Data button. 
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Let’s trim the geology file by searching for the Clip tool in the Geoprocessing window. 
 
In the Clip dialog box, select geology as the Input Features to clip, Watersheds as the Clip Features layer, and direct the 
Output Feature Class to your gislab4 folder with the name midsilgeology.shp. Click Run. 
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The new layer should appear in your All Watersheds layer (turn off “geology” to make sure). If it looks OK, use the 
Contents to copy-paste it to the Middle Siletz data frame. Rename the new layer Middle Siletz Geology and remove its 
replicate from the All Watersheds data frame. Activate the Middle Siletz data frame and right click on Middle Siletz 
Geology > Zoom to Layer. You should see the full extent of your newly clipped geology layer. Reorder the three layers in 
the Middle Siletz data frame so that you can see the streams, overlaid onto the buffers, overlaid onto the geology, like 
the screenshot below. 
 

 
 
You can examine the values of a field in a layer by changing its symbology. Practice this by right clicking on Middle Siletz 
Geology > Symbology. 
 
Select Unique Values from the Primary Symbology drop down. Change Field 1 to GEOLOGY. Select a color scheme of 
your choice. Right click the grey “all other values” field and choose Remove. Unique colors now represent each type of 
geology present in the Middle Siletz Geology layer. 
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You can individually change the colors for each type of geology by right clicking on the symbols in the Symbology dialog 
box or contents window and selecting an alternative. Let’s close the Symbology dialogue. 
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Dissolve 
 
Notice that we have four geologic classes but some redundancy exists in the number of polygons- some of the geology 
classes contain multiple polygon boundaries that border each other. We will perform a dissolve operation on Middle 
Siletz Geology to reduce data redundancy. 
 
Search for Dissolve in the Geoprocessing window and select it. 
 

 
 
In the Dissolve dialog box, make Middle Siletz Geology the Input Features. Direct the Output Feature Class to your 
gislab4 workspace and save it as midsildissgeo.shp. The Dissolve Field is GEOLOGY. Check Create Multipart Features. 
Click Run. 
 

 
 
Your dissolved output should appear in the Contents window. Open its Symbology. Rename the new layer Middle Siletz 
Dissolved Geology and change its symbology so that the unique values of GEOLOGY are displayed, like we did with the 
previous geology file. Right click on the “all other values” field (displaying the grey box in the Symbology dialogue box) 
and select Remove. Rename your new layer Middle Siletz Dissolved Geology. You should now have something like this: 
 



18 

 

 
 
Take a look at this new layer. You might toggle its visibility on and off to more closely examine the changes. You should 
notice that there are fewer polygons in this new layer than in the Middle Siletz Geology layer. This is because every 
polygon with the same geology type (Alluvium, Basalt, Marine Sediment, and Sedimentary) was dissolved into one 
feature; therefore, the new attribute table contains one row for each geology type. 
 
Save your map document. 
 
Point Files 
 
We will now examine a fictitious point representation of nests within our study watershed. Create a new data frame and 
name it “Lower Siletz.” Open the streams, watershed, and wombat shapefiles from your gislab4 folder into the new data 
frame. These should be located in your workspace\gislab4 folder.  
 
We'll take a few moments to become familiar with these files before you start the lab.   
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GIS Lab 4 Application:  Buffering Streams Based on Land Uses, Analyzing Nesting Locations within Stream Buffers, and 
Examining Geology Classes within Stream Buffers. 
 
We're going to examine the spatial distribution of nests for the Oregon Wombat. First, we'll create buffers around 
streams based on land use categories. 
 
In the Lower Siletz data frame you just created, create a new shapefile that contains the Lower Siletz Watershed 
polygon. 

1. Select the Lower Siletz watershed in the watersheds polygon layer. 
2. Right click on the layer in the Contents. 
3. Choose Data, then Export Features, and write the result as losilshed.shp to your workspace\gislab4 folder. 
4. Rename the new layer “Lower Siletz Watershed.” 
5. Remove the “watersheds” layer from your Contents. 

 
Let’s create a shapefile that represents only those streams in the Lower Siletz Watershed. 

1. In the Geoprocessing window, search for and select Clip. 
2. Choose streams as the Input Features, Lower Siletz Watershed as the Cdlip Features, and write the result to your 

workspace\gislab4 folder as losilstrms.shp. 
3. Click Run. 
4. Name the new layer “Lower Siletz Streams.” 
5. Remove the “streams” layer from your Contents.  

  
Change the symbology of your layers so you are able to differentiate them clearly and move “wombats” to the top of the 
Contents window. 
 

 
 
Let’s create a new attribute in the Lower Siletz Streams layer that we can use for buffering. 
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Open the Lower Siletz Streams attribute table. Add a field named buffer to this table by activating the Table menu and 
choosing Add Field. Assign buffer as the name, change type to Short Integer, and change the Precision and Length to 4. 
Save the new field using the Save button in the Fields toolbar.  
 

 

 
 
Use a combination of the Select By Attributes tool and the Field Calculator to enter the following buffer values: 
 
LUSE1  (CATEGORY)  BUFFER 
AG  (Agriculture)  200 
LT  (Large Timber)  300 
MT  (Mature Timber) 300 
ST  (Second Growth) 300 
TH  (Timber Harvest) 200 
YT  (Young Timber)  200 
 
An example of this two-step process for 300’ buffers around certain timber land uses would involve: 
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When you are done entering the buffer widths for all land use categories, select all 71 records.  
 
Close the table after you’re done. 
 
Create Buffers 
 
Make sure all 71 records are selected. In the Geoprocessing window, select Buffer from the Favorites or search for it in 
the Find Tools bar. 



23 

 

 
 
Select Lower Siletz Streams as the layer to buffer and use the graphic below as a guide. Make sure you change the 
Distance to Field and select buffer; this bases the buffer operation off of values in the field you created. Make sure you 
change the Dissolve Type to Dissolve all output features into a single feature. Write the output to your workspace 
location with the name losilbuff.shp. Click Run to create the buffers. 
 

 
 
Rename the new layer Lower Siletz Buffer. Your map should look similar to the graphic below. You should notice a size 
difference between the 200’ and 300’ buffers. The Lower Siletz Buffer attribute table should contain one polygon since 
you dissolved all attributes. If it contains more than one polygon the Dissolve Type was incorrect. 
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Assignment 4A. This is a team assignment. Please find a teammate and answer the five questions that appear on the 
following pages, type your answers, and turn in at the beginning of your next lab meeting. Be sure to include your 
names, lab day and time (e.g. Tuesday 10 AM), assignment number, and course title with your answers (9 points).  
 
1. What is the size in square feet of the buffer area contained in the Lower Siletz Buffer layer?  Round and report 

your answer to the nearest whole unit (do not report decimals). If you examine the attribute table for the Lower 
Siletz Buffer, you’ll notice that there is no area field. Follow the directions given earlier in Lab 1 and Lab 3 to 
create area and acre fields.   

 
 
The wombat shapefile in your Lower Siletz Watershed data frame contains point locations for nests from the elusive 
Oregon Wombat. Create a new shapefile that includes only the Wombats in the Lower Siletz Watershed. 
 
Rename the new layer to “Lower Siletz Wombats.”  Remove the original wombat layer by right clicking on it and 
choosing Remove from the pop-up menu. Take a look at the distribution of wombat nests scattered over the watershed.   
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2. How many wombat nests are there with a diameter of 3 feet or greater? (the NestDiam variable is expressed in 
feet)  
 
 
3. The Nestsize variable is a character variable and lists relative sizes of each nest. For all nests with a diameter of 3 
feet or greater, run a summary on the Nestsize variable and provide a table that lists the number of nests in each of 
the three size categories. 
 
 
4. Perform a clip operation on the Lower Siletz Wombats layer to create a new shapefile that shows only the wombat 
nests that fall within the previously-created buffer areas. Write this file to your workspace\gislab4 folder and call it 
nestbuff.shp. Examine the attribute table from this layer. For all nests with a diameter of 3 feet or greater - what is 
the distribution of nest sizes (small, medium, and large) that fall within the buffer zones? 
 
 
 
 
Let’s examine geology information for the Lower Siletz Watershed and determine the area each geology class occupies 
within stream buffers we created. To do this, open the geology shapefile into your data frame. It should be located in 
your workspace\gislab4 folder.  
 
Clip the geology layer to the Lower Siletz Watershed layer and save the output file as losilgeo.shp in your 
workspace\gislab4 folder.  
 
 
Rename the “losilgeo” layer to “Lower Siletz Geology” and remove the geology layer from your table of contents. 
Examine the geology classes for the new Lower Siletz Geology layer by accessing its Symbology options. Choose Unique 
Values under the Primary Symbology drop down menu, change Field 1 to Geology, and select Apply. 
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Do you notice anything unusual about the distribution of this variable? 

 
Let’s clean up some of the redundant line work in the layer. Perform a dissolve operation on the new “Lower Siletz 
Geology” layer. Search for dissolve in the Geoprocessing window. 
 
 
 



27 

 

Select Lower Siletz Geology as the Input Features, write the output to your workspace\gislab4 folder as losilgeodis.shp, 
and select GEOLOGY as the Dissolve Field. Click Run.  
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Rename the new layer Lower Siletz Dissolved Geology. Set the Primary Symbology to Unique Values and Field 1 as 
Geology. Click the Add All Values button under the Classes tab if the geology types do not automatically show up in the 
Symbology window. 

 
 
Clip the Lower Siletz Dissolved Geology layer to the Lower Siletz stream buffer layer. This should produce a buffer layer 
containing overlapping geology types. Below is a zoomed in graphic of what the layer should look like. Each color is a 
different geology type overlapping with the buffer layer. 
 

 
 

5. What is the acreage of the Alluvium geologic class (after a dissolve) within the stream buffers? Round and report 
your answer to the nearest whole acre.   
 
 
 
REQUIRED WRITTEN EXERCISE 
Assignment 4B. Include this with assignment 4A and work with the same team. Please answer question 3.12 
(Calculate RMSE) on page 69 of your text book. Show your work and report your response using three decimal places. 
2 points. 
 
Assignment 4C. Prepare a one or two page document that describes your final project. Please discuss the importance 
of your project and what you hope to find or demonstrate (one report per project team). Include reference to databases 
that you plan on using. Please include a cover page containing the paper title, class number (FE 257), date, author(s), 
and lab day and time (e.g. Tuesday 10 AM). Present your typed document (use double spacing please so comments can 
be inserted) at the beginning of the next lab meeting. 5 points. 


